"Pensando Android”

Introduzione alla programmazione mobile con
Android



Di che cosa parleremo...

Che cos'e Android?

Diffusione di Android

Linguaggio di programmazione Java su Android
Prime applicazioni su Android

Esempi Pratici



Di che cosa non parleremo...

 Html 5 con Android (esempi Phonegap e Titanium
studio)

e Sono applicazioni che facilitano molto la
programmazione ma non garantiscono la creazione
di progetti complessi

« La piattaforma nativa di programmazione
ottimizzazione e controllo del codice, debug, facilita
nel reperire documentazione, informazioni e
componenti di terze parti.

 E' necessario capire anche il suo linguaggio di
programmazione.



Android

Android € un sistema operativo per dispositivi mobili costituito da uno stack
software che include un sistema operativo di base, i middleware per le
comunicazioni e le applicazioni di base.Caratteristiche principali di Android
sono la struttura open source e il suo basarsi su kernel Linux.

La piattaforma usa il database SQLite, la libreria dedicata SGL per la grafica
bidimensionale (invece del classico server X delle altre distribuzioni linux) e
supporta lo standard OpenGL ES 2.0 per la grafica tridimensionale.

Le applicazioni vengono eseguite tramite la Dalvik virtual machine, una
macchina virtuale adattata per I'uso su dispositivi mobili. Android € fornito di
una serie di applicazioni preinstallate: un browser, basato su WebKit, una
rubrica e un calendario.

Dopo una serie di progetti avviati nel 2005 da Google , la prima versione
risale al 12 Novembre 2007 dove erano inclusi sdk, librerie del dispositivo e
documentazione in Inglese



Tappe crescita di Android

» 2005: Google acquista Android inc.
* 05/11/2007: nasce la Open Handset Alliance

e 12/11/2007: viene ri

e 23/10/2008: nasce |
T-Mobile G1

asciato I'SDK Android
primo telefono Android —




Versioni Android Esistenti

 Android 1.0

 Android 1.5: Cupcake

e Android 1.6: Donut

 Android 2.0: Eclair

« Android 2.2: Froyo

 Android 2.3: Gingerbread

« Android 3.0: Honeycomb (tablet)
« Android 4.0: Ice Cream Sandwich
 Android 4.1: Jelly Bean




Miglioramenti nelle versioni Android

. Android 1.5: Widgets , Tastiera a Schermo, Copia e Incolla, Video
. Android 1.6: Market

. Android 2.0: Multitouch, HTML 5 Browser, Gmaps GPS

. Android 2.1: Effetti 3D

» Android 2.2: JIT Compiler, Tethering, Applicazioni su SD

« Android 2.3: Near Field Communication (tecnologia wireless con
connessione a corto raggio fino a 10 cm)

« Android 3.0: Introduzione dei Fragment, CPU Multicore e Interfaccia per i
tablet

. Android 4.0: Multitasking migliorato, nuovo tema e riconoscimento facciale



Alcune aziende che utilizzano
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Diffusione di Android

» Grafico del 2 Luglio 2012

Version Codename 15 Distribution

1.5 Cupcake 3 0%
1.6 Donut 4 0.5% Anaeoid 2 1.3
21 Eclair T 4.7T%
2.2 Froye a 17.3%
i.3- Gingerbread 9 0.4%
.31

2.33- 10 63.6%
2.3.7

3.1 Honeycomb 12 0.5%
3.2 13 1.9%
4.0- Ice Cream 14 0.2%
4.0.2 Sandwich

4.03- 15 10.7%
4 0.4

Data collected during a 14-day period ending on July 2, 2012



Caratteristiche

« Open source
e Linux
« Framework Applicativo

 Dalvik Virtual Machine (nasconde al Sistema Operativo la gestione
della memoria e dei thread)

« Browser integrato basato su WebKit
« SQLite, OpenGL, Xml
Rich development environment

Supporto multimediale
Bluetooth, EDGE, 3G, WiFi, NFC

Fotocamera, GPS, bussola, accelerometro,giroscopio, sensore di
prossimita, sensore di luminosita, barometro, ...



Java

|| linguaggio principale con cui vengono
generati I programmi Android e il linguaggio
Java.

|| Java e un linguaggio che supporta la
programmazione orientata agli oggetti.

 Nasce nel 1992 per opera di James Gosling e
degli ingegneri della Sun Microsystems, ora
registrato dalla Oracle

» Attualmente e alla versione 7 (2011)



Caratteristiche del linguaggio Java

essere orientato agli oggetti;
essere indipendente dalla piattaforma;
contenere strumenti e librerie per il networking;

essere progettato per eseguire codice da
sorgenti remote in modo sicuro.



Programmazione Object Oriented

» Classe : modello astratto che crea oggetti
software

Al suo interno troviamo:
o Attributi ;: caratteristiche di una classe

 Metodi: comportamenti della classe , le sue
procedure



Classe (1/4)

« Una classe definisce un tipo
Esiste un costruttore
Metodo speciale per allocare gli oggetti
Non restituisce nessun tipo di ritorno (neanche void)

« Esiste un metodo toString() - serve a rappresentare I'oggetto in
formatestuale

« E' possibile usare l'overloading (sovraccarico) del costruttore
Esistono altri metodi importants

equals()
clone()
finalize()



Classe (2/4)

public class Contatore {

private int conta;

public void incr() {
conta++;

}



Classe (3/4)

public class Contatore extends Object{

private int conta;

public Contatore(){
super();

}

public void incr() {
conta++;

}




Classe(4/4)

public class Contatore extends Object {
private long conta;

public LessTrivial(long conta){
this.conta = conta;

public void incr() {
conta++;



Oggetti

Un oggetto € un rappresentante della classe

La creazione avviene mediante il richiamo di un
costruttore

| valori degli attributi sono tutti inizializzati a O
se interi, a false se booleani ecc

| valori degli oggetti attributo della classe sono
Inizializzati a null



Oggetti

« Contatore t = new Contatore(); // costruttore implicito
« NuovoContatore | = new NuovoContatore(); // errore!

* NuovoContatore |2 = new NuovoContatore(3); // giusto!

Contatore

NuovoContatore
12 >




Riferimenti e Puntatori

* Nel linguaggio Java non esistono | puntatori,
ma | riferimenti ovvero una locazione di
memoria automatizzata

Es: it.pinkopallino.Test@32123dd1
it.pinkopallino.test (package)

Test (classe)

32123dd1 (hashing dell'indirizzo di memoria)



Riferimenti e Puntatori

NuovoContatore
32123dd1

3




Ereditarieta (1/3)

e Concetto di astrazione che permette
-) riutilizzo del codice
-) creazione delle gerarchie di classi




Ereditarieta(2/3)

 Ae detta superclasse e B classe derivata

« B eredita gli attributi e i metodi della classe padre (solo attributi e
metodi pubblici e protected)

e Larelazione tra A e B & detta relazione is-a




Ereditarieta(3/3)

* public class B extends A {

private int b; // oppure protected
public void f2()

{

J



Override

» Ridefinisce una classe derivata di metodi gia
definiti nella superclasse

» public class B extends A{

@Override
public void f1() {
// ridefinisco le funzionalita di 1

;



Super

* Fa riferimento ai metodi e agli attributi definiti
nella superclasse

nel codice del metodi di una classe derivata

» public class B extends A{

@Override

public void f1() {
- super.f1();

}



Polimorfismo

 Un oggetto assume forme differenti
* Viene adottato il “binding dinamico”
A a = new A();
// b € un anche un oggetto di tipo A
A b = new B();

/I richiamo di un metodo definito nella classe
padre A a “runtime”

b.f1();



Final e Static

 final : qualcosa che rimane immodificabile in
riferimento alle classi

e« static : “qualcosa” che € Iinvocablile
indipendentemente dall'esistenza di oggetti
Istanza della classe

es. Math.sqrt(n) , main



Interfacce(1/2)

« Definisce un tipo senza definire un'implementazione,
usando costanti e metodi astratti

* Implementa l'eredita multipla

public interface Growable {
void grow(Fertilizer food, Water water);

J

public interface Eatable {

void munch();



Interfacce(2/2)

 public class Beans implements Growable, Eatable {

@Override

public void grow(Fertilizer food, Water water) {
/...

}

@Override

public void munch() {

/...

)



Generics (1/2)

Costruisce una classe Generica partendo da una o piu
classi specificate evitando problemi di conversione cast

Le classi Vector e ArrayList sono classi
generiche,dove specifichiamo il tipo degli elementi

- Vector<E>

- ArrayList<E>

dove E ¢ il tipo parametrico.

Esempio:

List<Studente> studenti = new ArrayList<Studente>();
studenti.add(new Studente(“Rossi”,”Mario”,”5n’’));



Generics (2/2)

e | tipi primitivi non vengono utilizzati come
parametri, al loro posto si devono usare leclassi

involucro (wrapper).
* E' noto anche come auto-boxing/unboxing.

* Vector<Integer> v = new Vector<integer>();



Programmare in Java con Android

 Ambiente di sviluppo Eclipse

« Sdk di Android (virtualizza il nostro sistema
operativo)

» Java Virtual Machine
» Cellulare con Android (se vogliamo velocizzare)
» E' funzionante su tutti i sistemi operativi



Dalvik Virtual Machine

. Sebbene la programmazione sul sistema Android avvenga in Java, non viene utilizzata la J2ME per ragioni
economiche e di performance. Al posto della V.M. per Java viene usata la Dalvik V.M.

Tale virtual machine ha le seguenti caratteristiche:

1) non accetta file .class ma un unico pacchetto .apk con un .dex che contiene tutte le classi. In questo modo di
ottimizzano le dimensioni del file (no ripetizioni costanti, no ripetizione header etc.). Non & di contro possibile
avere il caricamento dinamico delle classi, le classi caricabili sono solo quelle presenti nel .dex.

2) il bytecode € orientato ai registri (e non allo stack come la Java V.M.) per una maggiore velocita di esecuzione
e compattezza del codice (a scapito di una maggiore difficolta di compilazione e piu basso riuso);

Si ottiene cosi una riduzione del 50% della dimensione del bytecode prodotto e del 30% del numero di istruzioni
da eseguire.

Per aumentare le performance dalla versione 2.2 di Android & previsto anche la compilazione Just In Time a
granularita di trace che ha queste caratteristiche rispetto a un JIT a granularita di metodo:

1) utilizzo minimo di memoria aggiuntiva
2) tempo veloce di avvio a scapito di una minore ottimizzazione (e possibilita di condivisione tra processi).

Per aumentare la velocita di startup delle DVM su cui girano i vari processi, il caricamento della DVM stessa deve
essere molto veloce. Per questo si € usato una tecnica detta Zygote che permette la condivisione e |l
precaricamento di tutte le librerie core,



Application Layer

(Maﬁgtl;??v?sp;r ) Tl Fenie Developer Apps.




SDK

« Si procede innanzitutto all'installazione della SDK:

« La SDK per Android richiede l'installazione della SDK di
Java. Dopo aver installato Java, procediamo con
l'installazione per Android Opzionalmente ma vivamente
consigliato e assunto nei seguito, si puo procedere
all'installazione del plugin ADT per Eclipse

e Successivamente si  possono aggiungere altre
piattaforme e componenti alla SDK di Android tramite
I'Android SDK and AVD Manager. A esempio, possono
essere installate varie versioni della SDK, pacchetti di
documentazione o varie librerie.

« Maggqiori dettagli sono disponibili a link:
http://developer.android.com/sdk/installing.html



SDK

« Aspetto SDK Manager dopo l'aggiunta delle piattaforme (Window ->
Android SDK and AVD Manager):

+ Android SDK and AVD Manager

Wirtual devices SDK Location: C:\androidyandroid-sdk-windows
Installed packages
tvailable packages Installed packages
Settings 1 android SOK Tools, revision 10
about i=| Docurmentation for Android SOK, APL 2, revision 1
SOk Platform Android 2.2, API 8, revision 2
SOk Platform Android 2. 1-updatel, APL 7, revision 2
SOk Platform Android 2.0.1, APL 6, revision 1 (Obsolete)
SOk Platform Android 2.0, AP S, revision 1 {Obsolete)
SOk Platform Android 1.6, API 4, revision 3
SOk Platform android 1.5, API 3, revision 4
SOk Platform Android 1.1, AP 2, revision 1 {Cbsolets)
N Samples for SDK API 8, revision 1
5 Sarmples for SDK APL 7, revision 1
"B Google APIs by Google Inc., Android AP 8, revision 2

[

[=

Description

Update All... Delate. ..




SDK

« Aspetto SDK Manager dopo l'aggiunta delle piattaforme (Window ->
Android SDK and AVD Manager):

+ Android SDK and AVD Manager

Wirtual devices SDK Location: C:\androidyandroid-sdk-windows
Installed packages
tvailable packages Installed packages
Settings 1 android SOK Tools, revision 10
about i=| Docurmentation for Android SOK, APL 2, revision 1
SOk Platform Android 2.2, API 8, revision 2
SOk Platform Android 2. 1-updatel, APL 7, revision 2
SOk Platform Android 2.0.1, APL 6, revision 1 (Obsolete)
SOk Platform Android 2.0, AP S, revision 1 {Obsolete)
SOk Platform Android 1.6, API 4, revision 3
SOk Platform android 1.5, API 3, revision 4
SOk Platform Android 1.1, AP 2, revision 1 {Cbsolets)
N Samples for SDK API 8, revision 1
5 Sarmples for SDK APL 7, revision 1
"B Google APIs by Google Inc., Android AP 8, revision 2

[

[=

Description

Update All... Delate. ..




SDK

« La SDK contiene un emulatore mobile con il quale possiamo
selezionare il tipo di versione dell’AP| supportata da esso piu la
presenza o meno dei dispositivi hardware (es GPS, accelerometri,
quantita di memoria etc.)

List of existing Andraid Yirtual Devices located at C\Documents and Settings\Roncato, androidbawd

tvailable Packages A0 Mame Target Narne Flatform APT Level J=

Android 1.6

e

Delete. ..

Repair...

Details,..

Start...

Fefresh

i

~ & valid Android Virtual Device, =) & repairable Android Yirtual Device.
MW An Android Yirtual Device that failed to load. Click 'Details' to see the errar,




SDK

« Simulatore in partenza

= 5554:prova EIIEI[‘SZI




SDK

Simulatore in esecuzione

= 5554:prova

& 3:20PM
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Architettura

L'architettura & orientata al riuso dei componenti ottenuto tramite file
xml con la descrizione dell'aspetto dell'applicazione, file di risorse
esterni al codice Java.

| componenti di un'applicazione possono essere:

Activity: schermate visibili , la singola cosa che l'utente puo fare
Services: attivita in background

Content Provider: fornitori di contenuti condivisi

Broadcast Recelver: ricevono e reagiscono a eventi in broadcast,
sono consumatori di intent

Intent. componenti che attivano altri componenti, utilizzano Il
meccanismo del passaggi dei messaggi

Notifications: notificazioni agli utenti



Creazione di un progetto con
Android

 File -> New -> Project

Select a wizard —

Wizards:

e FTIOTTE Y d e TUT AU FrupeEet

—

4 Plug-in Project
b= General
- = Android
&% Android Sample Project
Ji Android Test Project
b= CVS

@ < Back MNext = Cancel Finish




Creazione di un progetto con
Android

Successivamente scrivere:

1) nome progetto

2) piattaforma su cui far girare I'applicazione
3) il nome dell'applicazione

)

)
4) il package
5) il nome dell'attivita
)

6) la minima piattaforma su cui deve girare l'applicazione.



Create Android Project

Select project name and type of project

Froject Name: F"r-:-gett-:-123|
Create new project in workspace
Create project from existing source

Create project from existing sample

JO0®

Ise default location

Working sets

[ ] Add project to working sets

A M H. M AT

—+

@ < Back Mext > Cancel Finish




Select Build Target

Choose an SDK to target

-Build Target

Target MName Vendor Flatform | API Le"
] Android 1.5 Android Open Source Project 1.5 =z

] Google APIs Google Inc. 1.5 L4

[ ] Android 1.6 Android Open Source Project 1.6 4

1 Google APIs Google Inc. 1.6 4

L1 Android 2.1 Android Open Source Project 2.1 r

[l Google APIs Google Inc. 2.1 7

] Android 2.2 Android Open Source Project 2.2 8

] Google APIs Google Inc. 2.2 8
Android 2.5.3 Android Open Source Project

] Google APIs Google Inc. 253 10

L1 Intel Atom =86 Sy Intel Corporation 253 10

L] DTS Add-On KNOCERA Corporation 253 10

L] Android 2.0 Android Open Source Project £.0 11

] Google APIs Google Inc. Z.0 11 —
[l Android 2.1 Android Open Source Project 21 12

1 Google APIs Google Inc. z.1 12

[1 Google TV Addon Google Inc. 21 12

Android + Google APIs

@ < Back MNext = Cancel Finish




i Application Info

Configure the new Android Project

Application Name:
FPackage MName:
Create Activity:

Mlimi mum SOk

FProgettol2®

it.pr-::-gett-:-123|

Progettol2Z2AcCtivity

10

[ ] Create a Test Project

= Baclk

Cancel

Finish

GTR

M H T

i+




Creazione di un progetto con
Android

 Dopo aver generato in automatico il progetto
verra fuori questo che segue



Creazione di un progetto con
Android

|m 5554:Terminale1.6

Hello World, HelloWorldActivity!




Creazione di un progetto con
Android

« Senza modificare il codice Java ma solo le
risorse del progetto che contengono le stringhe
possiamo modificare il progetto:



Creazione di un progetto con
Android

€ Menu =Eclipse gio 23 ago, 9.15 Q v g Br7rxo1z) O

Java - Progetto12 3 /res/values/strings.xml - Eclipse SDK
File Edit Refactor Run Nz te Search Project Window Help

mindl =/l B 2 &4 & B | $-0-Q- | HEG- ®@S 5 @ ® G @ B &ava ”
[ Package Explorer & = 5 ¥ = 8| |a mainxml 4| stringsxml (31 WhereAmljava a *stringsxml 2 7% S0O|gEou 2 ETe =g
p vl = .
i= MapSamples Android Resources (default) |
v 22 NewGame : ; An outline is not availabl
Resources ®O©® ©® 5 @® [5) (1) Az  Attributes for hello (String) I AT P At R,
~ '[EGIPT’OQEHOIQE Elements
Strings, with optional simple formatting,
N (S 5tri ith optional simple f i
_ ® hello (String) Add can be stored and retrieved as resources,
* @3 gen [Generated Java Files] et You can add formatting to your string by
(® app_name (String) . .
' =i Android 2.3.3 - Remaove. .. using three standard HTML tags: b, i, and .
» =\ Android Dependencies If‘;fou u.se an apos:trophe ora qluote inyour
- string, you must either escape it or enclose
= assets the whole string in the other kind of
» & bin Down enclosing quotes,
- =res Mame* hello
b (= drawable-hdpi Value* |Ciao Proval A

* = drawable-ldpi
* (= drawable-mdpi
* = drawable-xhdpi
v = layout

| main.xml

- = values

] — ;
=l Resources| = stringsxml

a AndroidManifestxml

B proguard-projectoa f Problems | & Lint Warnings |88 LogCat | @ Javadoc | B Console 32 @] Error Log « b | = B~ 4~ = O
Bl project properties L -
» 52 ProgettoACaso [2012-08-23 08:24:08 - Chapter 8 Where Am I] Android Launch!
= B [2012-08-23 08:24:08 - Chapter 8 Where Am I] adb 1s running normally.

A . s

|
R Android SDK Content Loader




Creazione di un progetto con
Android

* Che corrisponde a strings.xml

<?xml version="1.0" encoding="utf-8"?>

<resources>

<string name="hello">Hello World, HelloWorldActivity!</string>
<string name="app_name">Hello World Application</string>

</resources>



Creazione di un progetto con
Android

e Risultato

m 5554:prova

Prova '
Ciao, Prova!




Creazione di un progetto con
Android

package it.progetto123;
import android.app.Activity;
import android.os.Bundle;
/[Bundle: classe che mappa i valori tramite utilizzo di chiavi univoche
public class HelloWorldActivity extends Activity {
[** Called when the activity is first created. */
@Override
public void onCreate(Bundle savedinstanceState) {
super.onCreate(savedinstanceState);

setContentView(R.layout.main); //permette la visualizzazione di un layout
xml all'interno del nostro programma sulla cartella res/layout

}



Creazione di un progetto con
Android

 Funzionamento di un'Activity




Elementi di un applicazione Android

» Classe HelloWorldActivity.java

* File gestione stringhe strings.xml

* File gestione layout main.xml

* File AndroidManifest.xmi

» Classe R.java generata automaticamente



Elementi di un applicazione Android

« File gestione layout main.xml
<?xml version="1.0" encoding="utf-8"?>

<LinearLayout
xmlns:android="http://schemas.android.com/apk/res/android"

android:orientation="vertical"
android:layout_width="fill_parent"
android:layout_height="fill_parent">
<TextView
android:layout_width="fill_parent"
android:layout_height="wrap content"
android:text="@string/hello"/>
</LinearLayout>



Elementi di un applicazione Android

* Visualizzazione grafica di un layout xml

Editing config: default Anylocale |w | Android 233 |w | Create...
2.7in WVGA (Nexus One w | Fortrait) w | Normal w | Daytim w | Theme v
£ Palette A= ONONOREONO]

Ab TE xt“‘\""i 2%

Abl Large Text Hello World, Progetto123Activity!

Abl Medium Text

At Small Text

[ Text Fields

[ Layouts

[ Composite

[ Images & Media
[ Time & Date

[0 Transitions

1 Advanced

[ Custom & Library
=] Graphical Layout | (= mainxml

LinearLayout

ab| Textiew - "Hello Waorl




Elementi di un applicazione Android

« AndroidManifest.xml -> definisce la struttura e I metadati
dell'applicazione.

* Include un nodo per ogni componente (Attivita, Servizi, Content
Providers e Broadcast Receiver) e attraverso gli Intent Filter e i
Permission determina come ogni componente interagisce con
gli altri e le altre applicazioni.

* Laroot del file xml € il tag “manifest™



<?xml version="1.0" encoding="utf-8"7?>

<manifest xmins:android="http://schemas.android.com/apk/res/android"
package="it.progetto123"

android:versionCode="1"

android:versionName="1.0">

<uses-permission android:name="android.permission.INTERNET"></uses-permission>
ll[permessi di accesso a servizi

<uses-permission
android:name="android.permission.SIGNAL_PERSISTENT PROCESSES"></uses-permission>

<application android:icon="@drawable/icon" android:label="@string/app_name"> // specifica i
metadati dell’applicazione

<activity android:name=".Prova" android:label="@string/app_name">

<intent-filter> // componenti che gestiscono i vari intent

<action android:name="android.intent.action.MAIN" /> //lapplicazione di partenza

<category android:name="android.intent.category. LAUNCHER" /> /lapplicazione di partenza
</intent-filter>

</activity>

</application>

</manifest>



R.Java

Genera gli oggetti grafici su Android - Da non modificare
package it.progetto.123;

public final class R {

public static final class attr {

}

public static final class drawable {

public static final int icon=0x7f020000;

}

public static final class layout {

public static final int main=0x7f030000;

}

public static final class string {

public static final int app _name=0x7f040001;
public static final int hello=0x7f040000;

}
}



Ciclo di vita software Android

La superclasse Activity definisce eventi che governano il ciclo di vita di un’activity.
Spetta poi alle classi che estendono da Activity implementarli. Questi eventi sono:

onCreate() — chiamato quando I'activity viene lanciata per la prima volta
onStart() — chiamato quando I'activity diventa visibile all’'utente
onResume() — chiamato quando l'activity inizia ad interagire con l'utente

onPause() — chiamato quando l'attuale activity viene messa in pausa e un’activity
precedente viene ripristinata

onStop() — chiamato quando I'activity non € piu visibile all’'utente

onDestroy() — chiamato prima che l'activity venga distrutta (manualmente o dal
sistema operativo per liberare memoria)

onRestart() — chiamato dopo che l'activity era stata stoppata e quando € pronta ad
essere ripristinata



iclo di vita software Androi

User navigates
to the activity

App process
killed

Apps with higher priority
nead memory

Activity
running

Another activity comes
nto the foreground

The activity is
no longer visible

The activity is finishing or
being destroyed by the system

onDestroy()

Activity
shut down

User returns
to the activity

User navigates
to the activity



Intent

e L'intent e una descrizione astratta di
un'operazione da eseguire.

* || metodo startActivity() e utilizzato per far
partire una nuova attivita, che verranno messi a

nella stack superiore delle attivita.



Intent

public class MainActivity extends Activity {

/[ da qualche parte nell'attivita
Intent intent1 = new Intent(this, SubActivity1.class);

startActivity(intent1);
Intent intent2 = new Intent(this, SubActivity2.class);

startActivity(intent2);



Intent

public class SubActivity1 extends Activity {
// fai qualcosa con SubActivity1

}
public class SubActivity2 extends Activity {

// da qualche parte nella SubActivity2
Intent intent3 = new Intent(this,SubActivity3.class);

startActivity(intent3);

}
public class SubActivity3 extends Activity {

// fai qualcosa con SubActivity3

;



Intent

<manifest ... >

<application ... >

<activity android:name=".MainActivity"
android:icon="@drawable/icon.png"
android:label="@string/app_name"
<intent-filter>

<action android:name="...MAIN" />
<category android:name="...LAUNCHER" />
</intent-filter>

</activity>

<activity android:name=".SubActivity1".../>
<activity android:name=".SubActivity2".../>
<activity android:name=".SubActivity3".../>
</application>



Toast

Un toast € una messaggio a pop up che
compare sulla superficie della finestra.

HI®© 11:07PMm

7 . 0 0 AM
every day

Q-2 N AM

This alarm Is set for 7 hours and 52
minutes from now.

9:00* ™




Toast

Context context = getApplicationContext();
CharSequence text = "Hello toast!";
int duration = Toast.LENGTH SHORT;

Toast toast = Toast.make Text(context, text,
duration);

toast.show();



Toast

public class MiaActivity extends Activity {

private void toast(String text) {
Context context = getApplicationContext();
int duration = Toast. LENGTH_SHORT;
Toast toast = Toast.makeText(context, text,
duration);
toast.show();



View vs View Group

« La classe View € la base per le sottoclassi
chiamati "widgets" che offrono completamente
widget e oggetti dellinterfaccia utente
iImplementati, come campi di testo e pulsanti.

* La classe ViewGroup serve come base per le
sottoclassi chiamate "layout" che offrono tipi
diversi layout di architettura, come il layout
lineare, tabellare e relativo.



View vs View Group

l ViewGroup l
| ViewGroup l l‘-.."iew' l‘-.."iew'

l WView | l View | l WView |




Events

* Quando consideriamo gli eventi all'interno del
vostra Ul, I'approccio € quello di catturare gli
eventi dall'oggetto View specifico che l'utente
iInteragisce con lul.




Events

e Classi interne.
» Classi anonime.
* Origine e ascoltatore coincidenti.



main.xml

<?xml version="1.0" encoding="utf-8"7?>
<LinearLayout ...>
<TextView ... />

<Button android:text="@string/mioTesto"
android:id="@+id/mioBottone">
</Button>

</LiHearLayout>



Classi interne

protected void onCreate(Bundle savedValues) {

i?:utton mioBottone = (Button)findViewByld(R.id.mioBottone);
MioBottoneListener mioBottoneListener = new MioBottoneListener();

mioBottone.setOnClickListener(mioBottonelListener);
} I/ fine metodo onCreate

/| continua...



Classi interne

private class MioBottoneListener implements
android.view.View.OnClickListener {

@Override
public void onClick(View v) {

// fa qualcosa

}

Creazione di una classe interna
} I/ fine classe interna



Classi anonime

protected void onCreate(Bundle savedValues) {

Button mioBottone = (Button)findViewByld(R.id.mioBottone);
mioBottone.setOnClickListener(

new OnClickListener() {

@Override

public void onClick(View v) {

// fai qualcosa

}
1

Creazione di un ascoltatore

} I/ fine metodo onCreate



Origine e ascoltatore coincidenti

public class MiaActivity extends Activity implements
OnClickListener {

protected void onCreate(Bundle savedValues) {

Button mioBottone =(Button)findViewByld(R.id.mioBottone);

mioBottone.setOnClickListener(this);

}
}

// Implementa OnClickListener callback
public void onClick(View v) {
// fai qualcosa



Pubblicare su Play Store

1) Esportare l'applicazione

2) Registrarsi su Android Market/Google Play
(costo 25 9)



Bibliografia
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2) http://www.thenewboston.com
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4) http://it.wikipedia.org
5) http://en.wikipedia.org

6) http://www.dsi.unive.it/~taw -> Tecnologie e
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Marcello Cannarsa
Dott. In Informatica
Indirizzo: Via Padova 38 , 86039 Termoli(CB) —
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Sito web: http://www.marcellinux.it
Facebook & Twitter : marc3ll1nux
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